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CHEM 3 Advanced 
 

Assignment due Friday 5pm November 8 2013  
to m.jordan@chem.usyd.edu.au 

 
From Planck’s constant to Experiment 

Determining the rate coefficient for the isomerisation: NHC ↔ HCN 
 
Introduction 
The general aims in any study of chemical reactions are the determination of a rate coefficient 
for the process under the desired conditions, that is, how fast does the reaction proceed at a 
given energy or temperature, and an understanding of the microscopic dynamics underlying 
the reaction. All theoretical models for chemical reactions, however, involve varying degrees 
of approximation to the exact dynamics. The first approximation made is the Born-
Oppenheimer approximation: it is assumed that the motions of electrons and nuclei are fully 
separable. A rationalisation for this approximation is the fact that electronic motion is very 
much faster than nuclear motion (a proton has a mass approximately 2000 times that of an 
electron) and thus electrons are able to adjust essentially instantaneously to changes in the 
positions of the nuclei. The Born-Oppenheimer assumption allows a potential energy surface 
for the reaction to be defined and this is the starting point for all theoretical approaches to 
reaction dynamics. The potential energy surface is represented as V(q), where q defines the 
nuclear coordinates of the system. The first challenge is to determine V(q) and this is often 
done using experimental and/or theoretical data at discrete points, q, and defining a smooth 
surface using interpolation or fitting procedures. 
 
The second challenge in modelling a chemical reaction is to integrate the appropriate 
equations of motion on the potential surface. Ideally the Schrödinger equation would be used, 
however, in practise, classical equations of motion are often used. An alternative to modelling 
dynamics on the potential surface is to use a statistical theory. Statistical theories are so 
named because they incorporate dynamics in a statistical manner, they link the nature of the 
potential energy surface to the reaction rate coefficient in a single step, obviating the need for 
detailed dynamical integration. Because of their simplicity and ease of use, statistical theories 
have an important place in reaction kinetics. These theories, however, are approximations to 
a full classical model of the dynamics and it is important to quantify the nature of these 
approximations. 
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Theory 
The reaction studied here is perhaps the simplest unimolecular reaction, the isomerisation of 
hydrogen isocyanide. This reaction must proceed through a three-centred transition state. 

 
You will explore the potential energy surface using the GabEdit and Firefly computer 
programs; GabEdit is a graphical interface and Firefly is a program for calculating electronic 
wavefunctions and energies given a molecular geometry (ie it is an electronic structure 
program). The potential energy surface you will actually use for your classical trajectories was 
constructed by Murrell et al. (J. Mol. Spectrosc., 93, 307 1982) and was originally developed 
by fitting an appropriate functional form to a variety of experimental and theoretical data. 
Given the potential energy surface (its details are already included in the computer program 
you will use) the time evolution of the reaction will be followed using the classical equations of 
motion. 
 
For any given initial configuration of a molecule the classical laws (that is, Newton's laws) 
completely define the dynamics of the system. The classical trajectory that the system follows 
can be calculated by numerically integrating the equations of motion. There are many 
possible integration schemes but the program you will use employs one of the simplest: the 
velocity-verlet algorithm. 
 
Statistical theories attempt to calculate reaction rate coefficients without recourse to actual 
dynamics on the potential energy surface. Transition State Theory is such a theory and it 
involves two crucial assumptions: 
 
• there exists some critical configuration of a reacting molecule such that once the molecule 

has reached this configuration it will go on to irreversibly form products, and 
• energy will be randomised throughout the molecule on a time-scale that is rapid with 

respect to reaction. 
 
The critical configuration is called the transition state and the transition state theory 
expression for the reaction rate coefficient at a given temperature, T, is given by 
 

𝑘 𝑇 = !!!
!

!!
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where kB is the Boltzmann constant, h is Planck's constant, Q is the partition function at the 
transition state, QR is the partition function for the reactants and E0 is the energy difference 
between the reactants and the transition state (that is the critical energy required for reaction 
to occur). k(T) is called the canonical rate coefficient. 
 
Equation (2) is very similar to the Arrhenius expression for the rate coefficient that you will 
have met in first year. Indeed, it is possible to derive expressions for the frequency factor, A, 
and the activation energy Eact from transition state theory. 
 
A similar expression may be obtained for the microcanonical rate coefficient k(E), the rate 
coefficient at a fixed energy, E, of the system: 
 

𝑘 𝐸 =
!! !! !!!!!!!

!
!! !

  (2) 

 
where ρ(E) is the density of states of the reactant and ρ(E) is the density of states at the 
transition state. The density of states is a measure of the number of energy states available to 
the molecule at a given energy E, whereas the partition function is a measure of the number 
of energy states available at a given temperature T. 
 
In an isolated system the total energy of the system must be conserved. This makes it often 
preferable to work with microcanonical (fixed energy) rather than canonical (fixed 
temperature) systems. The canonical rate coefficient can always be obtained by averaging 
microcanonical rate coefficients over the appropriate, Boltzmann, distribution of energies: 
 

𝑘 𝑇 =
! ! ! ! !"# !!
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!

   (3) 

 
where equations (1) and (3) are of course equivalent. 
 
The canonical and microcanonical rate coefficients may be calculated if the vibrational 
frequencies and rotational constants of the reactant and transition state are known. The 
microcanonical reaction rate coefficient can also be determined dynamically from classical 
trajectory simulations. 
 
The Trajectory Computer Program 
The computer program you will use has a very descriptive name and is called traj.exe. This 
program calculates classical trajectories on the potential surface for reaction (1). The program 
will also calculate the total energy, harmonic normal modes and the values of any non-infinite 
rotational constants, for a given input reference geometry, on the Murrell et al. potential 
energy surface. You can also calculate these using the Firefly electronic structure program. 
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To run the trajectory program: open the folder CHEM2916 on the desktop and double click on 
the icon traj.exe. This will open a DOS window and start the program running. You will be 
prompted to input various parameters as you go. The program will tell you when it is running 
and it will also signal successful completion (this may take a while for the larger batches of 
trajectories). 
 
The trajectory information is output into a file called hnc.out. This file may be examined using 
any editor (for example Notebook or Word) and suitable numbers cut and pasted into any 
graphing or spreadsheet program. Instructions for importing data into Excel (so it may be 
plotted) are given in the Appendix. 
 
NOTE: The hnc.out file will be overwritten each time the program runs so, if you would like to 
keep any particular output file, you will need to change its name. 
 
Normal Mode Analysis 
This involves fitting a quadratic form for the potential energy surface to the region immediately 
surounding the input nuclear geometry (or reference configuration). The fitting procedure 
enables harmonic vibrational frequencies to be calculated for the reference configuration and 
also allows the harmonic displacement vectors that describe the nature of each harmonic 
motion, to be determined. 
 
If the reference configuration corresponds to a minimum on the potential energy surface (that 
is, a stable molecule) then the potential will be concave up (that is, the vibrational frequencies 
will be positive) in the 3N-6 (or 3N-5) degrees of freedom corresponding to vibrational motion 
of a non-linear (or linear) molecule with N atoms. 
 
The potential should be flat (that is, the harmonic frequencies should be zero) for the 3 
degrees of freedom corresponding to translational motion of the centre-of-mass and should 
also be zero for the 3 (or 2) degrees of freedom corresponding to the overall rotation of the 
system about the centre-of-mass. In practise, however, there tends to be coupling between 
the overall rotational motion of the molecule and its bending vibrations. If this is the case the 
rotational degrees of freedom will yield small real or imaginary frequencies (they are dirty 
zeroes). 
 
If the reference configuration corresponds to a transition state then the potential energy will 
be concave down in the direction of the reaction coordinate and concave up for the other 
degrees of freedom (that is, a transition state corresponds to a first order saddle point on the 
potential energy surface). For a non-linear transition state there should be one imaginary 
harmonic frequency corresponding to the reaction coordinate, three zero frequencies 
corresponding to translational motion, three almost zero frequencies corresponding to overall 
rotation and 3N-5 real harmonic frequencies corresponding to vibrations. The nature of the 
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reaction coordinate may be determined by examining the normal mode displacement vector 
corresponding to the imaginary frequency. The easiest way to do this (and to examine the 
nature of the vibrations themselves) is to animate the vibrations using GabEdit or to draw a 
diagram of the molecule and indicate the normal mode displacement of each atom in terms of 
a vector. 
 
Rotational Constants 
Rotational constants for the reference configuration are calculated from the principal moments 
of inertia of the molecule which are determined by diagonalising the moment of inertia tensor. 
This is a generalisation of the expression I = µ r2 that you have already met for a diatomic 
molecule. 
 
Trajectory Initial Conditions 
The initial starting configuration of a trajectory (its initial position and momentum) will, in 
classical mechanics, completely determine the outcome of the trajectory. In order to 
accurately calculate properties of the potential energy surface like reaction rate coefficient a 
large number (an ensemble) of trajectories with appropriate initial conditions must be 
evaluated. This is because the error associated with such a numerical process reduces only 
slowly with the total number of trajectories calculated. 
 
The trajectories you will calculate utilise a microcanonical ensemble of initial conditions, that 
is, the initial conditions correspond to a fixed initial energy for the molecule (rather than, say, 
a fixed initial temperature). The energy chosen is 2.5 eV. To simplify the analysis, all the 
trajectories are initiated with zero angular momentum, that is, the HNC molecules are not 
rotating. 
 
Each set of trajectories will be completely specified by the input random number “seed” used 
to determine appropriate initial conditions. The initial conditions themselves are chosen by 
sampling configurations at intervals along a Markov walk through the possible configuration 
space. The reactant equilibrium geometry is the starting point for this walk and steps are 
taken in configuration space (the space of all positions and momenta) maintaining the desired 
total energy. These steps are accepted or rejected using a microcanonical weighting. If there 
are a sufficient number of steps between each sampling point, and there is a rejection ratio of 
approximately 50% for each step, this method provides a very good means of sampling the 
desired distribution of initial conditions.  You do, however, need to exclude already reacted 
geometries from the initial conditions. 
 
Trajectory Final Conditions 
Each trajectory is integrated for a maximum amount of time. This should not be less than 2ps 
(ie think about the various timescales for molecular motion). If, during this time, the trajectory 
reacts (or it fails to conserve energy, see part B) the trajectory will be automatically stopped 
and the next trajectory initiated. The criterion used to define a reaction is when the line joining 
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the C-N centre-of-mass to the H atom makes an angle with the C-N line of centres greater 
than or equal to 113.1 degrees. 
 
Trajectory Output 
The classical trajectory program has two distinct modes of operation, if the number of 
trajectories chosen is less than 4, then detailed information about each trajectory is printed. 
This information includes the total energy of the trajectory, the relative error in the total energy 
and the values of the three bondlengths describing the molecule. For larger numbers of 
trajectories only average values of these various energy parameters are output.  
 
Following completion of a set of trajectories, the total number of reacting trajectories is 
determined and the probability of reaction, along with its standard error, is output. Finally the 
distribution of times taken for the reaction to occur is output.  
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Your Tasks: 
 
Part A: Calculate the thermal reaction rate coefficient k(T), for reaction (1) 
For this you will need to determine the vibrational frequencies, rotational constants and 
relative energies for the HNC molecule and the transition state to HCN. 
 
If we assume that the potential energy surface for both the reactant and transition state 
configurations is separable into independent vibrations and rotations we can write the overall 
partition function for either the reactant or transition state as: 
 

𝑄 = 𝑄!!"#𝑄!"#!   (4) 
 
where 𝑄!!"#  is the partition function for the ith vibrational mode and 𝑄!"#  is the rotational 
partition function. 
 
There are also translational and electronic contributions to the partition functions but these will 
all cancel in this case, where we have a unimolecular isomerisation (ie the mass of the 
reactant and product is the same) on a potential energy surface representing a single 
electronic state (ie the electronic partition function is the same). 
 
For a classical harmonic oscillator with vibrational frequency νi, in cm–1 

 

𝑄!!"# =
!!!
!!!!

  (5) 

 
NOTE: this is different to the quantum vibrational partition function that you would have seen 
in lectures in second year!! 
 
The partition function for the rotation of a linear molecule is given by: 
 

𝑄!"# =
!!!
!!!"

  (6) 

 
where σ is the symmetry number, c the speed of light (in cm.s–1) and B the degenerate 
rotational constant (in cm–1). In general there will be three rotational constants for a molecule. 
If the molecule is linear two of these rotational constants will have the same value, they will be 
degenerate. 
 
For a non-linear molecule: 
 

𝑄!"# =
!
!

!!!
!!

!
! !

!.!.!

!
!
  (7) 
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where A, B and C are the three rotational constants of the molecule. 
 
For non-symmetric molecules (like HNC) the symmetry number, σ = 1. (For symmetric 
molecules, σ is the order of the rotational subgroup of the molecular point group – see 
CHEM3917, and for example, the planar D3h methyl radical has a symmetry number of 6 – 
the rotational subgroup comprises {E, C3, C3

2, 3C2}). 
 
On the Murrel et al. potential energy surface (which is parametrised to experiment) the 
hydrogen isocyanide reactant configuration, HNC, is linear and is characterised by an H-N 
bondlength of 0.9936  Å and a C-N bondlength of 1.1645 Å. This geometry (in terms of 
Cartesian coordinates) will eventually need to be input in to the program traj.exe. In the 
meantime, however, you will run your own electronic structure calculations. 
 
You will use the GabEdit interface to generate the input file for the Firefly electronic structure 
program. 
 
The HNC molecule 
Drawing a geometry: 

1. Open GabEdit (Start > All Programs > GabEdit or click on the GabEdit icon on the 
desktop) 

2. Click on the icon that looks like a green benzene molecule. 
This should open a window which will allow you to start 
drawing. 

3. There are two basic modes of operation of the drawing 

program. Either you are editing the structure or viewing it. Click on the Pencil icon,  , 
to start drawing. 

4. You will draw the HNC molecule. Start by clicking on the Periodic Table icon,  , and 
selecting carbon. If the H-button is depressed, hydrogens are added automatically. We 
don’t want this so unclick this button. Now click the Pencil once in the drawing window 
to draw a carbon atom. If you make a mistake use ctrl<z>. 

5. Before adding the nitrogen, click the Measure button, . This adds an extra tab to the 
right hand side of the active screen and will let you adjust the C–N bondlength to 
something close to 1.16 Å. Now reselect the Pencil and use the Periodic Table to 
select a nitrogen atom. 

6. Now with the Pencil button depressed, click and drag about a centimetre, using the 
Measure tab to get about the right bondlength. Your screen should look something 
like: 
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You can use the Translate, , Swivel, , or Zoom, , buttons to modify the view 

of your molecule. Clicking on the  button optimizes the view of the molecule. 
7. Now reclick the Pencil button, use the Periodic Table to select hydrogen, and draw 

the N–H bond by clicking and dragging from the nitrogen atom pulling out the bond to 

about 0.99 Å. Use the Swivel button, , to check your molecule is linear. You can 

use the Move Selected Atoms button, , if necessary. 
 
Writing the input file: 	
  
 

1. You will now do a calculation on this molecule. Click on the 
PC GAMESS icon on the top bar of the main GabEdit 
screen (not the drawing screen!).  
This will bring up a label stating “New FireFly input file”. 

2. Choose Fixed Symmetry (should be C1).  
3. Under Run Type, select Equilibrium Geometry+Frequencies. 
4. SCF Type should be RHF.  
5. We will do a Hartree-Fock calculation. This is a mean field theory so electrons see the 

mean (average) field of all other electrons in the molecule. In this calculation there are 
no “2-electron” terms so there is no electron correlation. Leave these options alone. 

6. You now need to select a basis set. 6-31G should not be too arduous. Choose it. 
7. Leaving everything else alone, click OK. In the main GabEdit window, an input file for 

Firefly should now appear. You might have to move the molecule window out of the 
way to see it. It should look something like: 

 
! ================================================================ 
! Input file for FireFly 
! ================================================================ 
 $SYSTEM MWORDS=20 $END 
 $CONTRL RUNTYP=Optimize $END 
 $STATPT  HSSEND=.T. OptTol=1e-5 NStep=500 $END 
 $CONTRL SCFTYP=RHF $END 
 $CONTRL ICHARG=0  MULT=1 $END 
 $BASIS GBASIS=N31 NGAUSS=6 NDFUNC=1 $END 
 $DATA 
Molecule specification 
C1 
C  6.000000 -3.330199  0.000000  0.000000 
N  7.000000 -2.175156  0.000000  0.000000 
H  1.000000 -1.340242  0.000000  0.000000 
 $END 
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Running the Calculation 
 

1. Click on the pair of cogs in the top bar of the main GabEdit 
screen. Make sure that FireFly is selected as the program. 
Type a sensible filename where it says “Save data in file”. 

2. Ensure that the desktop/student directory is selected as the Local Folder 
3. Click OK. The program runs. 
4. Clicking on the log file tab at the top will allow you to see the progress of your 

calculation. Refresh this with Update/End. If it is successful, it will finish with 
 

EXECUTION OF FIREFLY TERMINATED NORMALLY 
 

If this has occurred, you should proceed. If there is a problem ask me! Take a moment to 
peruse this file. 
 
 
Viewing the results 
 

1. You have now performed a quantum 
chemical calculation and your geometry 
optimization and frequency calculation 
has completed. Click on the little red 
and blue d-orbital in the top bar of the main GabEdit screen to bring up the results 
viewer. 

2. Right click in the window. Select Geometry>Geometry Firefly>Read the last geometry 
from a FireFly output log file. Select your file and click Open. Your geometry should be 
displayed. 

3. Clicking  will optimize the view. Swivel it around and enjoy your molecule. The blue 
arrow in the window represents the dipole moment vector. 

4. Right click, Render>Label>show distances, will show that the optimized C–N bond 
length is 1.165 Å and the N–H bondlength is 0.980 Å. That is, your molecule should 
look like: 

5. The optimized moments of intertia were calculated in the log file. It should report the 
rotational constants as: 

 
THE ROTATIONAL CONSTANTS ARE (IN GHZ) 
   0.00000    45.84639    45.84639 
 

If your values are slightly different (ie in the final decimal place), don’t worry, the numerical 
minimisation routine modifies the geometry until the forces are close to (ie not exacly) zero, 
within a preset tolerance, so your final answer will depend on your initial guess at the 
transition state geometry. 
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To view vibrations: 
 

1. Right-click, Animation>Vibration in the viewing window (ie where your optimized 
molecule is). In the Vibration window that opens on the right hand side of the screen 
select File>Read>Read a FireFly output file. Select your output file and click Open. 

2. The lowest frequencies would normally be the three translations and two rotations (for 
a linear molecule). These should be zero, but because of the numerical optimization 
you will see 3 frequencies very close to zero (the translations) and 2 near zero low 
frequencies, which can be real or imaginary (the rotations). If there is a negative 
frequency in this window (strictly speaking it should be imaginary which will be 
indicated  with a capital “I” in the .log file) this indicates an imaginary vibrational 
frequency – a negative second derivative.  Your molecule should have optimised safely 
to a minimum energy geometry, so all of its vibrational frequencies should be real. 
Highlight the frequency you want to animate and click Play. Once your molecule is 
vibrating you can move from normal mode to normal mode. You can change the view 
using the Swivel button, but only after you have pressed Stop. 

 
In your report, you should: 
• list the degrees of freedom you expect to obtain for HNC 
• identify the corresponding frequencies from the normal mode analysis 
• animate the normal modes and include a schematic diagram of each normal mode motion  

(include translations and rotations). This does not have to be very detailsd (I can run the 
calculation too!). 

• Compare your calculated vibrational frequencies to the frequencies calculated on the 
empirical Murrel et al. potential energy surface: 493.8, 493.8, 2060.3 and 3795.8 cm–1, and 
from experiment: 521, 2033 and 3651 cm–1 (R. A. Creswell and A. G. Robiette, Mol. Phys. 
36, 869, 1978). 

• Compare your calculated rotational constants to those from the empirical Murrel et al. 
potential energy surface (ie paramterised to experiment) of 45.78837 GHz. 

• Record the total energy of your optimised HNC molecule, ie look for “FINAL ENERGY” in 
the output .log file. 
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The Transition State 
The transition state for this reaction is triangular and can be characterised by a C-H distance 
of 1.1204 Å, a C-N distance of 1.1393 Å and an N-H distance of 1.4953 Å. 
 
Follow the basic procedure above to obtain a starting geometry, you may need to use the 

Move Selected Atoms button, . Similarly to what you have already done for HNC, we 
will use this geometry as a starting point for an electronic energy optimisation of the transition 
state geometry. So draw a starting geometry and make an input file. In Firefly, the transition 
state optimisation, however, makes the implicit assumption that you know what you are doing! 
The easiest (and most efficient) way to optimise to a transition state is to start with a 
knowledge of the curvature (ie the second derivatives) of the potential energy surface at your 
starting geometry. Firefly assumes that you know how to do this and know how to put these 
second derivatives (the “Hessian”) into the Firefly input file. We can “cheat”, however, by 
editing the input file GabEdit makes to include the appropriate commands. Make an input file 
for your guess at the transition state and select Run Type as transition state (keeping RHF 
and 6-31G as the method and the basis set). This time your input file will look like: 
 
! ================================================================ 
! Input file for FireFly 
! ================================================================ 
 $SYSTEM MWORDS=20 $END 
 $CONTRL RUNTYP=Sadpoint $END 
 $STATPT OptTol=1e-5 NStep=500 $END 
-- Put here the $HESS card. 
     You can obtain it from your old frequencies calculation (.pun 
or .irc file) 
 $CONTRL SCFTYP=RHF $END 
 $CONTRL ICHARG=0  MULT=1 $END 
 $BASIS GBASIS=N31 NGAUSS=6 NDFUNC=1 $END 
 $DATA 
Molecule specification 
C1 
C  6.000000 -4.613764  2.857557  0.000000 
N  7.000000 -3.482648  2.827791  0.000000 
H  1.000000 -4.421375  3.961090  0.000000 
 $END 
 
We need to edit this file so that it automatically calculated the second derivatives to start with 
(the Hessian), that is we need to add HESS=calc to the $STATPT command line and delete 
the comments in the lines below it. Your edited file should look something like: 
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! ================================================================ 
! Input file for FireFly 
! ================================================================ 
 $SYSTEM MWORDS=20 $END 
 $CONTRL RUNTYP=Sadpoint $END 
 $STATPT OptTol=1e-5 NStep=500 HESS=calc $END 
 $CONTRL SCFTYP=RHF $END 
 $CONTRL ICHARG=0  MULT=1 $END 
 $BASIS GBASIS=N31 NGAUSS=6 NDFUNC=1 $END 
 $DATA 
Molecule specification 
C1 
C  6.000000 -4.613764  2.857557  0.000000 
N  7.000000 -3.482648  2.827791  0.000000 
H  1.000000 -4.421375  3.961090  0.000000 
 $END 
 
When this job has finished, cut the optimised saddle point geometry out of the output .log file 
and use it in a new Run Type as Frequencies calculation.  When you have finished you 
should get something like:  
 
1245.89 I     4.80        2.59        1.98        0.03 
   0.05       0.44     2137.66     2548.65 
 
For the vibrational frequencies (the I signifies imaginary). You want one imaginary frequency 
for your transition sate. When you pull up these frequencies in GabEdit, the imaginary 
frequency will be shown as a negative. 
 
If your frequencies are slightly different (ie after the decimal point for the 3 large magnitude 
frequencies), don’t worry, the numerical minimisation routine modifies the geometry until the 
forces are close to (ie not exacly) zero, within a preset tolerance, so your final answer will 
depend on your initial guess at the transition state geometry. 
 
The rotational constants shoud be something like: 
 

THE ROTATIONAL CONSTANTS ARE (IN GHZ) 
    399.30043    54.98729    48.33159 

 
In your report, you should: 
• list the degrees of freedom you expect to obtain for the transition state 
• identify the corresponding frequencies from the normal mode analysis 
• animate the normal modes and include a schematic diagram of each normal mode motion  

(include translations and rotations). This does not have to be very detailsd (I can run the 
calculation too!). 
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• Compare your calculated vibrational frequencies to the frequencies calculated on the 
empirical Murrel et al. potential energy surface: 1131.5 I, 2223.9 and 3130.0 cm–1. 

• Compare your calculated rotational constants to those from the empirical Murrel et al. 
potential energy surface (ie parameterised to experiment) of 434.4076, 58.48243 and 
51.54337 GHz. 

• Record the total energy of your optimised transition state, ie look for “FINAL ENERGY” in 
the Firefly output .log file. 

• Calculate the energy difference between the HNC reactants and the transition state 
geometries. Using the energy units in the Firefly output you will get this in atomic units 
(Hartrees). You can convert atomic units to kJ.mol–1  by multiplying by 2625.5. Note: the 
energy difference between the reactants and transtition state on the Murrel et al. potential 
energy surface is 1.023755 eV (I’ll leave you to change the units on this one yourselves). 

 
The motion corresponding to the imaginary vibrational frequency describes the reaction 
coordinate for the isomerization. 
 
• What does the reaction coordinate look like? 
• Is the trajectory final condition (listed above) appropriate? 
 
• Tabulate the energies, harmonic vibrational frequencies and rotational constants for the 

reactant and transition state configurations and, using equations (1), (4), (5), (6) and (7), 
calculate the thermal rate coefficient, k(T), for the isomerisation reaction at 2000 K. (I would 
encourage you to do this using Excel) for both the values from the Murrel et al.  potential 
energy surface and the ones that you have calculated. 

• If you are really keen,( no extra marks, only your own satisfaction) you can see how 
making the basis set bigger (6-311G is bigger than 6-31G as is adding polarisation and/or 
diffuse functions) affects your results and you can also look at how including electron 
correlation using either density functional theory (eg B3LYP1) or perturbation theory (eg 
MP2) affects the results. 

 
Note: the degree of freedom corresponding to the reaction coordinate is not included in 
calculating Q+, that is, we ignore the imaginary frequency. 
 
• How is your result likely to differ from a quantum transition state theory value?  
• Under what conditions will quantum mechanical tunneling play a role in this reaction? 
 
NB at this point you might like to do these calculations (and the microcanonical equivalents in 
Part C; equation 9) before the next tutorial so you can ask me any questions that come up. 
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Part B: Running Classical Trajectories 
 
Because the trajectory is integrated numerically, although the total energy of the system 
should remain constant (that is, energy is a conserved quantity) this need not be the case in 
practise. There are some integration techniques that are guaranteed to conserve energy, they 
are called symplectic integrators, but they are very complicated to implement. The velocity-
verlet algorithm is not a simplectic integration scheme. A good test for whether the integration 
scheme for a trajectory is valid is whether it conserves energy to within a given tolerance. In 
this case the tolerance is set to 0.1% of the total energy of the system and if a trajectory 
violates this criterion it is stopped and excluded from any statistical analysis. 
 
In your report you should include: 
• What factors will influence the conservation of total energy? 
 
• Run a single trajectory starting from the reactant configuration using the parameters: 
timestep = 0.1 
number of trajectories = 1 
maximim number of timesteps per trajectory = 2000 
 
and the initial random number seed 
ir = 632398683 
 
The coordinates can be determined by placing the HNC, say, along the z-axis: 
 
Coordinates of the H atom (x,y,z) 
0.0 0.0 0.0 
Coordinates of the C atom (x,y,z) 
0.0 0.0 2.1581 
Coordinates of the N atom (x,y,z) 
0.0 0.0 0.9936 
 
You may like to experiment with the parameter nprint, which determines how many trajectory 
steps are taken between each analysis of the trajectory. 
 
In your report: 
• Plot the relative error in the total energy and values of the three bondlengths as a function 

of time.  
• Describe this trajectory in words. 
 
Ideally the trajectory you just calculated will have reacted. Unfortunately some of the 
processors on the PC's in the computer lab may be slightly dubious and the trajectory may 
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not have reacted. If this is the case experiment with different random number seeds until you 
find a reactive trajectory. 
 
Regardless of whether the first attempt reacted, you may like to experiment in running other 
individual trajectories. 
 
To accurately determine a reaction rate coefficient a large number of trajectories need to be 
calculated.  
 
In your report: 
• Using the preset initial energy of 2.5 eV and a timestep of 0.1 time units calculate 10, 20 

and 100 trajectories, ensuring the trajectories are integrated for at least 2 ps (why?).  
 
Note that 2 ps will require integration for up to 20,000 timesteps and integration of 100 
trajectories may take quite a while! 
 
• Plot your results for the reaction probability vs number of trajectories, along with error bars. 
If you are particularly keen you may like to consider adding further points to this graph. 
 
(Do not use the same random number for each run! Why?) 
 
• What would you expect to happen if these trajectories were allowed to continue 

indefinitely? 
 
Each time the program runs it will overwrite the output file hnc.out, so you may like to change 
the name of any file you wish to keep. 
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Part C: Decay Lifetimes 
 
Statistical theories would predict that the isomerisation process shows first order behaviour 
(that is, the concentration of HNC should  decay exponentially over time): 
 

N(t) = N(0) exp[ – k t ]  (8) 
 
where N(0) is the total size of the ensemble (that is the total number of valid trajectories), N(t) 
is the number of unreacted trajectories at time t and k is the reaction rate coefficient. 
 
To determine whether this approach is valid for the HNC isomerization, we will analyse a 
large enough ensemble of trajectories so that the statistical errors in the trajectory data are 
sufficiently small. I'm not sure what the best way to do this is, so we'll see as we go along! 
 
In your report you should: 

• Plot N(t)/N(0) vs t using suitable axes.  
• Comment on your results. 
• Suggest a possible reason for this behaviour. Would you expect the nature of the plot 

to change if the energy of the molecule were substantially increased? 
 

(Hint: the plot you obtain will not show first order behaviour) 
 

• Describe an experiment that would give you similar data. 
• Fit appropriate lines to your graph to obtain limiting estimates of the first order rate 

coefficient k(E) for E = 2.5 eV.  
• You may like to discard from your analysis any trajectory reacting in less than 0.1 ps 

(why?). 
 
The rate coefficient k(E) at 2.5 eV may also be calculated using transition state theory, that is 
equation (2).  The expressions for the density of states at the transition state and the reactant 
configurations may be calculated similarly to the partition functions that you used earlier. 
 
Classically, the transition state expression is given by equation (3), repeated below: 
 

𝑘 𝑇 =
! ! ! ! !"# !!

!!!
  !"!

!

! ! !"# !!
!!!

  !"!
!

  (3) 

 
where the numerator for k(E) is: 

!×!! !!!!
!
!

!"× !!
!
! !∗!∗!∗

!
! !!!

!!! !!
∗   (9) 
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and the denominator k(E) is: 
 

 ℎ× !!

!"×!!"   !!!!!
!!!

  (10) 

 
 

where the νi* are the (real) vibrational frequencies at the transition state and A*, B* and C* are 
the transition state rotational constants.  
 
The νi are the reactant vibrational frequencies and B is the degenerate rotational constant for 
the linear reactant molecule. NOTE: there are four vibrational frequencies for the reactant but 
only two for the transition state. For those of you mathematically inclined the density of states 
is the inverse Laplace transform of the partition function. 
 
In your report: 

• Calculate k(E) at 2.5 eV using transition state theory. How does k(E) vary with energy? 
 
This expression has been obtained assuming vibrational, rotational and translational motion 
are separable. In fact, the translational term is not included in either expression because, 
without loss of generality, we can consider a coordinate frame in which there is no centre-of-
mass motion. 
 
In your report: 

• Comment on the differences between the trajectory based and transition state theory 
values for k(E). 

• What differences might you expect from these calculated numbers and an 
experimental value obtained at 2.5 eV? (ie what have we left out of the two models, 
how could we improve the models and how would the rate coefficient be affected by 
these factors). 
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Appendix: Plotting your results 
 
To plot your results you will need to import data from the notebook file into a graphing utilility, 
for example, Microsoft Excel. 
 
To do this: 
 
Open Excel  
Go to the File menu 
Go to Open 
look for Text Files (*.prn; *.txt; *.csv) and double click on the appropriate notebook file in the 
HNC Trajectories folder. This will then bring up the Text Import Wizard. 
 
Step 1: 
Check the Original Data Type as Fixed Width 
Choose the row at which to start importing data (use the scrollbar to help you) 
set the File Origin} as Windows ANSI 
Click on Next >  
 
Step 2: 
Create the column delimiters by clicking on an appropriate column or clicking and dragging an 
existing delimiter. Remove delimiters by double clicking. 
Click on Next >  
 
Step 3: 
Select the column data format by checking General for all the columns 
Click on Finish 
 
You will get some lines of text imported into Excel as well as the numbers. Delete these 
before plotting the data. 


